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Overview
Welcome to the NC Manufacturing Review User's Guide. This guide is intended for users who need to 
become quickly familiar with the NC Manufacturing Review Version 5 product. 

This overview provides the following information:

●     NC Manufacturing Review in a Nutshell

●     Before Reading this Guide

●     Getting the Most Out of this Guide

●     Accessing Sample Documents

●     Conventions Used in this Guide.

NC Manufacturing Review in a Nutshell
NC Manufacturing Review provides fast and easy visualization of 3D NC Manufacturing data. It provides 
easy access, visualization, and browsing of CATIA V4 and V5 manufacturing data but also any CAM systems 
pre-processing specifications and results. This product delivers infrastructure basics to create and integrate 
machining workbenches and additional machining strategies with a full integration in V5 NC Manufacturing 
platform.

NC Manufacturing Review offers the following main functions: 

●     Multi-CAM reviewer

●     Import and review NC Data (APTfile, CLfile or NC code) which may be CATIA or other files

●     Import and review CATIA V4 NCMILL and NCLATHE programs

●     Import and review CATIA V5 CATProcess part programs

●     Infrastructure for other V5 NC Manufacturing programming products

●     Infrastructure for partner products.

Before Reading this Guide
Before reading this guide, you should be familiar with basic Version 5 concepts such as document windows, 
standard and view toolbars. Therefore, we recommend that you read the Infrastructure User's Guide that 
describes generic capabilities common to all Version 5 products. It also describes the general layout of V5 
and the interoperability between workbenches.

You may also like to read the following complementary product guide, for which the appropriate license is 
required: 

●     NC Manufacturing Infrastructure User's Guide: explains how to use common NC Manufacturing 
functionalities.

Getting the Most Out of this Guide



To get the most out of this guide, we suggest that you start reading and performing the step-by-step 
Getting Started tutorial. This tutorial will show you how to how to review NC manufacturing data. 

Once you have finished, you should move on to the User Tasks section, which gives more complete 
information about the product's functionalities. The Reference section provides useful complementary 
information.

The Workbench Description section, which describes the commands that are specific to NC Manufacturing 
Review, and the Customizing section, which explains how to customize settings, will also certainly prove 
useful.

Accessing Sample Documents
To perform the scenarios, you will be using sample documents contained in the 
doc/online/ncgug_C2/samples or doc/online/ncgug_D2/samples folder. For more information about this, 
refer to Accessing Sample Documents in the Infrastructure User's Guide.
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Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and 
understand important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:

●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:

This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task

functionalities that are new or enhanced with this release

allows you to switch back to the full-window viewing mode



Graphic Conventions Indicating the Configuration Required 

Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or the Advanced Tasks

Workbench Description

Customizing

Reference

Methodology

Glossary

Index

Text Conventions

The following text conventions are used:

●     The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●     File -> New identifies the commands to be used.



●     Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button... Whenever you read...

 
●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the document 
window, ...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move

●     Right-click (to select contextual menu)



What's New?
No enhancements in this release.



Getting Started
Before getting into the detailed instructions for using NC Manufacturing Review, this tutorial is intended to 
give you a feel of what you can accomplish with the product.  

It provides the following step-by-step scenario that shows you how to use some of the key functionalities. 

Reviewing NC Manufacturing Data



Reviewing NC Manufacturing Data

This task shows you how to review NC manufacturing data.

1. Enter the NC Manufacturing Review workbench and click File > Open to select a CATProcess. 

The PPR tree appears.

2. Double click the Pocketing operation in the tree. The Pocketing dialog box appears. 



3. The properties of the operation are organized in tab pages. You can browse and, under certain conditions, edit these 
properties. 
To end the consultation of the pocketing data, just click Cancel to close the machining operation dialog box.

4. Click the Import APT, Clfile or NC code icon  or right-click the program and select Import APT, Clfile or NC code 

from the contextual menu.

The NC File Import dialog box appears. 

5. Select the type of NC data file to import using the combo and specify the file to import. 

Click OK to import the specified file.

The PPR tree is updated with the manufacturing information of the imported file.

NC data objects appear in the Manufacturing Program for each tool change in the imported file. 
A Tool path object is associated to each NC data object.

All tools referenced in the imported NC file appear in the Resources List. 



Note that you can replay the imported APT file using the contextual menu command. 

There is also the possibility of editing the tool path using contextual menu commands.



User Tasks
The user tasks you will perform in the NC Manufacturing Review workbench involve reviewing 
manufacturing data in a Version 5 environment. This manufacturing data includes Version 5 CATProcess 
documents, Version 4 NC Mill and NC Lathe models, and NC data such as APT source files.

Browse V5 Manufacturing CATProcess
Browse V4 NC Mill Model

Browse V4 NC Mill Operation
Associate APT File to NC Mill Program

Browse V4 NC Lathe Model
Browse V4 NC Lathe Operation

Associate APT File to NC Lathe Program
Import NC Data

Replay and Simulate Tool Path
Output NC Data

Generate Documentation
Edit Tool Path

 



Browse a V5 Manufacturing CATProcess

This task shows you how to browse a V5 Manufacturing CATProcess in the NC Manufacturing Review 
workbench.

1. Enter the NC Manufacturing Review workbench and click File > Open to select a CATProcess.

2. Double click the Pocketing operation in the tree. The Pocketing dialog box appears. 



3. The properties of the operation are organized in tab pages as follows:

 the parameters of the machining strategy, which are divided up into different tabs

 the geometry to be machined 

 the tool that is used in the operation

 the feedrates and spindle speeds 

 the macros (transition paths).

 the PP word syntaxes (this tab is displayed for some operation types only).

You can browse and, under certain conditions, edit these properties. 

If the license of the application allowing creation /edition of the machining operation is 
available, the OK button is accessible: the machining operation can be modified.

Otherwise, the OK button is inactive: the machining operation cannot be modified.

The Tool Path Replay functionality is accessible:

●     if a tool path is present on the machining operation (computed status)

●     if no tool path but the license of the application allowing creation/edition of the machining 
operation is available.

Otherwise the Replay button is inactive (not accessible).

4. Just click Cancel to close the machining operation dialog box.



Browse a V4 NC Mill Model

 
This task shows you how to browse a V4 NC Mill Model in the NC Manufacturing Review workbench.

For this task you should use a CATProduct that includes one or more V4 models.

1. Enter the NC Manufacturing Review workbench and click the Read Manufacturing Data from a V4 Model 

icon . The following dialog box appears.

2. Navigate to the desired CATproduct and click Open. 

3. If the CATProduct includes more than one V4 model, the following dialog box appears. 



Select the desired V4 model and click OK. 

4. The Select NC Mill Sets dialog box appears showing the list of NC Mill sets in the selected model in the left-
hand column. 

Use the arrow buttons to move the NC Mill sets to be processed to the right-hand column. One or more 
sets can be selected and ordered using the arrow buttons. Click OK. 

A progression bar appears giving the status of the NC Mill set and machining operation being processed.



The selected NC Mill set is added to the Process List at Part Operation level. The PPR tree is updated with 
the manufacturing information of the selected NC Mill set.

A program V4 Program.1 containing all the machining operations and tool changes of the NC Mill set is 
added at Manufacturing Program level. 

  A product Product1 is created and associated to the selected NC Mill set.

All tools referenced in the NC Mill set are added to the Resources List.

 5. Double click the Part Operation entity in the PPR tree to access the Part Operation editor. Use the editor:
●     to associate a machine to the Part Operation

●     to associate a stock to the Part Operation. This is useful if you want to do material removal simulation 
at a later stage (that is, once NC data has been associated to the V4 program).

6. Double click a machining operation in the program to browse its properties. Please refer to Browse a V4 
NC Mill Operation for more information.



●     Only geometry with SHOW status in the V4 model is displayed.

●     You can now associate NC data to your V4 program. Please refer to Associate an APT File to an NC Mill 
Program for more information.



Browse a V4 NC Mill Operation

 
This task shows you how to browse a V4 NC Mill Machining Operation in the NC Manufacturing Review workbench.

1. In the specification tree containing a Part Operation originating from V4, double click the machining operation 
to be browsed (see Browse a V4 NC Mill Model). 

The machining operation browse panel appears. 

The properties are organized in tab pages as follows:

 the parameters of the machining strategy 

 the geometry to be machined 



 the tool that is used in the operation

 the feedrates 

 the macros (transition paths) 

 the PP word syntaxes.

Parameters of the machining strategy page  

The set of machining options of the NC Mill machining operation are displayed along with their values and any 
associated parameters names. The right field is set to None if the option is not parameterized.

Note that all possible option values are listed for each operation. 
However, some options may not be used by the operation. For example, the Distance between Paths option 
may be set to Scallop Height, Number of Paths or Distance between Paths. In the panel above it is set to 
Scallop Height. In this case only the Scallop Height value is useful: the Number of Paths and Distance between 
Paths values should be ignored.

Geometry to be machined  

The set of possible geometry entity types are listed for the operation.  Entity types that are not referenced by 
the selected operation are dimmed. Entity types that are referenced by the selected operation can be 
highlighted by clicking the corresponding checkbox. 

Only geometry with SHOW status in the V4 model is considered to be linked to the operation.

Tool used in the operation  

The V4 tool information is listed along with the corresponding CUTTER/ statement. If a Detailed tool was used 
no information is displayed.

This is the information of the previous Tool Change operation of the NC Mill set.



Feedrates   

The set of feedrates of the NC Mill machining operation are displayed along with their values and any 
associated parameters names. This is set to None if the feedrate is not parameterized.

Note that all possible feedrates are listed for each operation. 

Note that no spindle speeds are displayed as these were not managed for NC mill operations.

Macros (transition paths)  

All possible macro types of the operation are listed along with the corresponding macro names. If no macro of 
a given type is linked to the operation, the name field is left blank.

PP word syntaxes  

This tab page contains information for CYCLE type operations only.

2. Just click Cancel to close the machining operation panel.



Associate an APT File to an NC Mill Program

 
This task shows you how to associate an APT file to an NC Mill program using the NC Manufacturing Review 
workbench.  

This association consists in creating a tool path for each operation by extracting the necessary information 
from the APT file. This allows verification and simulation of these operations.

You must have a APT source file generated by the CATNC utility for the imported NC Mill program.

Note that CATNC must be executed with the PPRINT processing option set to PPRINT (that is, *PPR or 
*PPRINT keyword set to 1). 
This is to allow identifying the part of the tool path corresponding to each operation and so to be able to 
define the tool path of each operation.  Identification is processed by means of the PPRINT OPERATION 
NUMBER statements.

1. Select the V4 program in the specification tree.

2. Select the Associate Output NC File to a Program icon . The dialog box for selecting the NC file 

appears.

3. Select the NC file to associate to the program.

The tree is updated with tool paths defined on the machining operations.



 
●     The machining operations with Computed status have their own tool path which can be replayed 

and, if a stock geometry is linked to the Part Operation, simulated.

●     APT association must be done in a CATIA session working in the same units as those in which APT 
was generated.

●     The APT association can only be done on V4 type programs.

●     The APT association can only be done whenever there is a PPRINT OPERATION NUMBER statement 
and there are as many entities in the program as PPRINT OPERATION NUMBER statements in the APT 
(except the first one, which defines CATIA0).

●     The APT association may be done if there are COPY and TRACUT type entities present, and Tool Path 
Replay is available for these entities.

●     A 'continue' statement followed by a PPRINT OPERATION NUMBER statement may present a 
problem. Example :

PPRINT OPERATION NUMBER : 6 
PPRINT *** TOOL NO SF8-1093-10 6.00DIA. .125CRAD. .625LOC. 4.500SL$ 
PPRINT OPERATION NUMBER : 7 
PPRINT *************************************************************** 

You should remove all unnecessary 'continue' statements before APT association.

●     APT association is not possible for files containing OUTPUT PROFILE, TOOL FLANK OUTPUT, TOOL 
CENTER OUTPUT, PQR OUTPUT, or NURBS statements.



Browse a V4 NC Lathe Model

 
This task shows you how to browse a V4 NC Lathe Model in the NC Manufacturing Review workbench.

For this task you should use a CATProduct that includes one or more V4 models.

1. Enter the NC Manufacturing Review workbench and click the Read Manufacturing Data from a V4 Model 

icon . A dialog box like the one shown below appears.

2. Navigate to the desired CATproduct and click Open. 

3. If the CATProduct includes more than one V4 model, the following dialog box appears allowing you to 
select the desired V4 model.

The Select NC Lathe Sets dialog box appears.



4. Select one or more NC Lathe sets from the list and click OK. 

A progression bar appears giving the status of the NC Lathe set and machining operation being 
processed.

The selected NC Lathe set is added to the Process List at Part Operation level. The PPR tree is updated 
with the manufacturing information of the selected NC Lathe set.

A program V4 Program.1 containing all the machining operations and tool changes of the NC Lathe set 
is added at Manufacturing Program level. 

A product Product1 is created and associated to the selected NC Lathe set.
All tools referenced in the NC Lathe set are added to the Resources List.



 5. Double click the Part Operation entity in the PPR tree to access the Part Operation editor. Use this editor:
●     to associate a lathe machine to the Part Operation. In the Machine Editor remember to set the Spindle 

axis and Radial axis to appropriate values (XY or ZX, for example) 

●     to associate a stock to the Part Operation. This is useful if you want to do a Video material removal 
simulation at a later stage (that is, once NC data has been associated to the V4 program).

6. Double click a machining operation in the program to browse its properties. Please refer to Browse a V4 
NC Lathe Operation for more information.

●     Only geometry with SHOW status in the V4 model is displayed.

●     You can now associate NC data to your V4 program. Please refer to Associate an APT File to an NC 
Lathe Program for more information.



Browse a V4 NC Lathe Operation

 
This task shows you how to browse a V4 NC Lathe Machining Operation in the NC Manufacturing 
Review workbench.

1. In the specification tree containing a Part Operation originating from V4, double click the 
machining operation to be browsed (see Browse a V4 NC Lathe Model). 

The machining operation browse panel appears. 

The properties are organized in tab pages as follows:

 the parameters of the machining strategy 

 the geometry to be machined 

 the tool that is used in the operation

 the feedrates and spindle speeds.



Parameters of the machining strategy page  

The set of machining options of the NC Lathe machining operation are displayed along with their 
values.

Geometry to be machined  

The set of possible geometry entity types are listed for the operation.  Entity types that are not 
referenced by the selected operation are dimmed. Entity types that are referenced by the 
selected operation can be highlighted by clicking the corresponding checkbox. 

Only geometry with SHOW status in the V4 model is considered to be linked to the operation.

Tool used in the operation  

The displayed tool corresponds to the previous Tool Change operation of the NC Lathe set.



If a Detailed tool was used no information is displayed.

Feedrates   

The set of feedrates and spindle speeds of the NC Lathe machining operation are displayed along 
with their values.

2. Just click Cancel to close the machining operation panel.



Associate an APT File to an NC Lathe Program

 
This task shows you how to associate an APT file to an NC Lathe program using the NC Manufacturing 
Review workbench.  

This association consists in creating a tool path for each operation by extracting the necessary information 
from the APT file. This allows verification and simulation of these operations.

You must have a APT source file generated by the CATLATH utility for the imported NC Lathe program.

Note that CATLATH must be executed with the PPRINT processing option set to PPRINT (that is, *PPR or 
*PPRINT keyword set to 1). 
This is to allow identifying the part of the tool path corresponding to each operation and so to be able to 
define the tool path of each operation.  Identification is processed by means of the PPRINT OPERATION 
NUMBER statements.

1. Select the V4 program in the specification tree.

2. Select the Associate Output NC File to a Program icon . The dialog box for selecting the NC file 

appears.

3. Select the NC file to associate to the program.

The tree is updated with tool paths defined on the machining operations.



 
●     The machining operations with Computed status have their own tool path which can be replayed 

and, if a stock geometry is linked to the Part Operation, simulated.

●     APT association must be done in a CATIA session working in the same units as those in which APT 
was generated.

●     The APT association can only be done on V4 type programs.

●     The APT association can only be done whenever there is a PPRINT OPERATION NUMBER statement 
and there are as many entities in the program as PPRINT OPERATION NUMBER statements in the APT 
(except the first one, which defines CATIA0).

●     A 'continue' statement followed by a PPRINT OPERATION NUMBER statement may present a 
problem. Example :

PPRINT OPERATION NUMBER : 6 
PPRINT *** TOOL NO SF8-1093-10 6.00DIA. .125CRAD. .625LOC. 4.500SL$ 
PPRINT OPERATION NUMBER : 7 
PPRINT *************************************************************** 

You should remove all unnecessary 'continue' statements before APT association.

●     APT association is not possible for files containing OUTPUT PROFILE, TOOL FLANK OUTPUT, TOOL 
CENTER OUTPUT, PQR OUTPUT, or NURBS statements.



Import NC Data

This task shows you how to import NC data in the NC Manufacturing Review workbench.

1. Enter the NC Manufacturing Review workbench. 

 2. Select the Manufacturing Program in the tree.

Click the  icon or right-click the program and select Import APT, Clfile or NC code from the contextual menu. The NC File 

Import dialog box appears.

3. Select the type of NC data file to import using the combo: 
●     APT

●     Clfile

●     NC code.

4. Click Input File. 
In the dialog box that appears navigate to the desired NC data file and click Open.

5. Click OK to import the selected file.

The PPR tree is updated with the manufacturing information of the imported file. 



NC data objects appear in the Manufacturing Program for each tool change in the imported file. 
A Tool path object is associated to each NC data object.

All tools referenced in the imported NC file appear in the Resources List.

●     If selected NC data type is NC Code, you must specify the Post Processor in the proposed list. 

●     Sample  Post Processor parameter files are delivered with the product in the folder
\Startup\Manufacturing\PPPar
which provides NC output for various machine types.
Post Processors are provided by Cenit, Intelligent Manufacturing Software (IMS), and ICAM Technologies Corporation.

●     Select the type of Post Processor parameter files to be made available for selection in the NC Code tab page using 
Tools > Options > Machining > Output tab. If the output option is set to None, no parameter files will be available for 
selection. 

●     For information about how to acquire Post Processor parameters files that provide machine specific NC code output, 
please contact your IBM representative.  

●     If no PP provider is defined in the Tools > Options > Machining > Output tab, the PP File selection combo will not appear in the 
NC File Import dialog box.

●     It is not possible to import APT files containing OUTPUT PROFILE, TOOL FLANK OUTPUT, TOOL CENTER OUTPUT, PQR OUTPUT, 
or NURBS statements.



Tool Path Replay and Simulation
The tasks for using capabilities such as tool path verification and material removal simulation are 
documented in the NC Manufacturing Infrastructure User's Guide.

For a Part Operation originating from V4 NC Mill or NC Lathe, Replay and Simulation is only available 
whenever a successful APT association has been done.

Replay Tool Path: Select the Tool Path Replay icon then specify the display options for an 
animated tool path display of the manufacturing program of machining operation.

Simulate Material Removal (P2 functionality): Select the desired icon in the Tool Path Replay 
dialog box to run a material removal simulation either in Photo or Video mode.

file:///E|/www/jmndocr14/Doc/online/mfgug_C2/mfgugbt0401.htm
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Generate NC Data
The tasks for using capabilities such as production of NC output data are documented in the NC 
Manufacturing Infrastructure User's Guide. 

For Version 5 programs, you can generate NC output data when all machining operations have their 
associated tool path. For operations which have no associated tool path, the applications that are used to 
create and compute tool paths must be available.

For Version 4 programs issued from NC Mill or NC Lathe, you can generate NC output data when the APT 
association is done on the program.

 

●     Generate APT Source Code in Batch Mode: Select the Generate NC Output in Batch Mode icon 
then select the manufacturing program or part operation to be processed and define the APT 
source processing options.

●     Generate Clfile Code in Batch Mode: Select the Generate NC Output in Batch Mode icon then 
select the manufacturing program or part operation to be processed and define the Clfile 
processing options.

●     Generate NC Code in Batch Mode: Select the Generate NC Output in Batch Mode icon then select 
the manufacturing program or part operation to be processed and define the NC code processing 
options.

●     Generate a CGR File in Batch Mode: Select the Generate NC Output in Batch Mode icon then 
select the manufacturing program or part operation to be processed and define the CGR file 
processing options.

Generate NC Output in Interactive Mode: Select the Generate NC Code Interactively icon then select 
the manufacturing program or part operation to be processed and define processing options.
Batch Queue Management. Manage tool path computation outside the interactive session, with the 
possibility of scheduling the execution of several batch jobs.
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Documentation Generation
The tasks for using capabilities such as production of NC documentation are documented in the NC 
Manufacturing Infrastructure User's Guide. 

 Generate NC Documentation: Select the Generate Documentation icon to produce shop floor 
documentation in HTML format. 

Screen capture for associating a JPEG image to an activity (that is, part operation, manufacturing 
program,  machining operation, and so on).
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Edit Tool Path
Before using any of the functions below, the tool path must be computed. All of these functions are 
accessed via the tool path contextual menu.

Point Modification: either move or remove a point on a tool path.

Area Modification: edit an area on a tool path. 
You can select areas of the tool path by using: 

●     one point on the tool path and deciding whether you want to use the portion before or after it

●     two points and deciding whether you want to use the part of the tool path that is between the 
two points or outside of the two points

●     a contour and deciding whether you want to use the part of the tool path that is inside or 
outside of the contour

●     a polyline and deciding whether you want to use the part of the tool path that is inside or 
outside of the contour.

Translation: apply a Translation transformation to a tool path.

Rotation: apply a Rotation transformation to a tool path.

Mirror: apply a Mirror transformation to a tool path.

Reverse: reverse a tool path.

Connection: connect tool paths.

Change Approach and Retract: add or remove approaches and retracts in a tool path.

Check Tool Length: check a tool path to identify all the points where the tool holder collides 
with the part.



Workbench Description
This section contains the description of the commands that are specific to the NC Manufacturing Review workbench, which is illustrated below. 

Toolbars
Specification Tree

 



NC Manufacturing Review Toolbars
The NC Manufacturing Review workbench includes several icon toolbars.

The NC Review Management toolbar is specific to this workbench and contains the following commands 
for managing the review.

See Import NC Data.

See Browse Version 4 NC Mill model 
or Browse Version 4 NC Lathe model. 

See Associate APT to an NC Mill program 
or Associate APT to an NC Lathe program. 

The other toolbars are common to all NC workbenches. The commands of these toolbars are documented in 
the NC Manufacturing Infrastructure User's Guide.

The Manufacturing Program toolbar contains the following commands for creating part operation and 
manufacturing program entities.

 
See Part Operation

 
See Manufacturing Program

The NC Output Management toolbar contains the following commands for reviewing different types of NC 
output. 

See Tool Path Replay and Simulation

See Tool Path Computation in Batch Mode

See Tool Path Computation in Interactive Mode

See Batch Queue Management

file:///E|/www/jmndocr14/Doc/online/mfgug_C2/mfgugbt0501.htm
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See Documentation Generation

Screen capture for associating a JPEG image to an activity (that is, part 
operation, manufacturing program,  machining operation, and so on).

During NC Documentation generation, an IDL interface can be called in order 
to read the image associated to the activity. A URL link must be made from 
the HTML documentation to the image in order to retrieve it in the generated 
HTML documentation.

The Auxiliary Commands toolbar contains a number of commands for various tasks.

 

 Import Tools.  
See procedure for searching tools described in Select or Create a Tool.

 
See Replace Tools

Choice between No Display, Displaying Tool Path or Display Geometry of selected 
operation.

Allows manual update of activity status in tree.

The Machining Features toolbar gives access to the Manufacturing View.

See Manufacturing View.
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Specification Tree
Here is an example of a Process Product Resources (PPR) specification tree for NC Manufacturing Review.

Process List is a plan that gives all the activities and machining operations required to transform a part 
from a rough to a finished state. 

●     Part Operation defines the manufacturing resources and the reference data.

●     Manufacturing Program is the list of all of the operations and tool changes performed. The example 
above shows that: 

●     Drilling.1 is complete and has not been computed

●     Drilling.2 is complete but has been computed (by means of a replay)

●     Drilling.3 does not have all of the necessary data (indicated by the exclamation mark 
symbol)



●     Drilling.4 has been deactivated by the user (indicated by the brackets symbol)

●     Drilling.5 has been modified and needs to be recomputed (indicated by the update symbol).

Product List gives all of the parts to machine as well as CATPart documents containing complementary 
geometry. 
Resources List gives all of the resources such as machine or tools that can be used in the program.



Customizing

This section describes how to customize settings for Machining.

Before you start your first working session, you can customize the settings to suit your working habits. Your 
customized settings are stored in permanent setting files: they will not be lost at the end of your session.

Other tasks for customizing your Machining environment are documented in the NC Manufacturing Infrastructure 
User's Guide:

Build a Tools Catalog
Access External Tools Catalogs
PP Word Syntaxes 
NC Documentation 

1. Select Tools > Options from the menu bar: the Options dialog box appears. 

2. Select the Machining category in the tree to the left. The options for Machining settings appear, organized in tab 
pages. 

3. Select the tab corresponding to the parameters to be customized.

Parameters in this tab... Allow you to customize...

General general settings for all Machining products

Resources tooling, feeds&speeds and resource files 

Operation machining operations

Output PP files and NC data output

Program manufacturing programs (sequencing, and so on)

Photo/Video material removal simulation 

4. Set these options according to your needs. 

5. Click OK to save the settings and quit the Options dialog box. 
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General

This document explains how to customize general settings for Machining products.

Select the General tab, which is divided up into areas.

Parameters in this area... Allow you to customize...

Performance settings for optimized performance

Tree Display display of the specification tree

Color and Highlight colors of displayed geometry and parameters

Tool Path Replay tool display during tool path replay

Complementary Geometry handling of geometry necessary for manufacturing

Design Changes use of the Smart NC mode and enhanced detection of design 
changes.

Performance

Click the Optimize button in order to automatically set a number of the Machining options for optimized performance. These 
options are listed in the Information dialog box that appears: 



If you click Yes, these options will be set as described in the dialog box. Note that, if needed, you may locally reset any of 
these options.
If you click No, the options will remain with their current settings.

The Information box also lists some recommendations for manually setting other options that have an influence on 
performance. 

Tree Display

●     Select the checkbox if you want the status of activities in the tree to be updated automatically. 

●     If this checkbox is not selected:

❍     you can update activity status manually in your workbench using the Update Status icon  in the Auxiliary 
Commands toolbar. 

❍     the status of the activity after a manual update is masked at the first action on the node (for example, edit, replay, 
collapse/expand of a parent node). To retrieve the status of the activity you must select the Update Status icon 
again. 



If this checkbox is not selected, performance is improved.

 By default, the checkbox is not selected.

Color and Highlight

●     Select the colors to be used for identifying the various manufacturing entities by means of the combos. 
Note that for Geometry that is not found or not up to date, you can select the colors used to display the valuated 
parameters in the corresponding Operation or Feature dialog boxes.

●     For certain entities, you can select the corresponding checkbox to use highlighting. 
Performance is improved when all the Highlight checkboxes are selected.

Tool Path Replay

Display tool near cursor position on tool path

Select this checkbox if you want to display the tool near your cursor position on the trajectory during a tool path replay

Display tool center instead of tool tip

Select this checkbox if you want to display the tool center point instead of the tool tip during a tool path replay



Display circles

Select this checkbox if you want to display each circular trajectory as a circular arc instead of a set of discretization points. 
The extremities of the circular arc are indicated by means of 'O' symbols.
This allows better control of the Point by Point replay mode, where it is necessary to make several interactions to replay a 
circle (because of its representation by a set of points). With the graphic representation as a circle, only one interaction is 
necessary to perform the replay.

 By default, these checkboxes are not selected.

Color of feedrates

Select the colors to be used for identifying the various feedrate types by means of the combos. The selected colors will be 
displayed in the Different colors replay mode.

Complementary Geometry

Select the checkbox to create a CATPart dedicated to manufacturing-specific geometry in the Product List of the PPR tree.

 By default, the checkbox is not selected.

Design Changes

Smart NC mode

Select this checkbox to activate the Smart NC mode. In this mode, an image of the geometry selected in machining 
operations is kept to allow analysis of design changes.
Performance is improved when this checkbox is not selected.

Optimized detection of design changes

Select this check box to enable a geometrical comparison mode in order to more precisely determine the design change 
status of machining operations.

 By default, these checkboxes are not selected.



Resources

This document explains how to customize resource settings for Machining products.

Select the Resources tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Catalogs and Files the path name for resource files

Tool Selection the selection of tools

Automatic Compute from Tool Feeds and 
Speeds

the update of feeds and speeds according to tooling data

Tool Query Mode in Machining Processes 
Instantiation

tool queries in machining processes

Catalogs and Files 

Enter the path of the folder containing tool catalogs, PP tables, macros, and machining processes. You can choose a folder by clicking 
the [...] button.

You can concatenate paths using:

●     a semi colon (;) character for Windows NT platforms.

●     a colon (:) character for UNIX platform.

For example, if the concatenated folders E:\DownloadOfCXR12rel\intel_a\startup and e:\users\jmn\NC in the figure above contain PP 
tables, then those PP tables will be available for selection in the Part Operation's Machine Editor dialog box.

Please note that:

●     PP tables must be contained in folders named Manufacturing\PPTables

●     tools must be contained in folders named Manufacturing\Tools.

Tool Selection 

Automatic query after modification

Select this checkbox if you want to to activate an automatic query after each modification of a tool parameter. Performance is improved 
when this checkbox is not selected.

Tool preview after selection

Select this checkbox if you want to preview the tool after selection.

 By default, these checkboxes are selected.



Automatic Compute from Tool Feeds and Speeds

Feedrate attributes of the operation

Select this checkbox if you want the Automatic Update of Feedrates option to be set by default in the Feeds and Speeds tab page of 
machining operations.
This option allows feedrates of operations to be automatically updated whenever feedrate information on the tool is modified.

Spindle attributes of the operation

Select this checkbox if you want the Automatic Update of Speeds option to be set by default in the Feeds and Speeds tab page of 
machining operations.
This option allows spindle speeds of operations to be automatically updated whenever speed information on the tool is modified.

 By default, these checkboxes are selected.

Tool Query mode in Machining Processes Instantiation

Select the type of Tool Query to be executed when a Machining Process is instantiated:

●     automatically computed Tool Query

●     interactively defined Tool Selection in case of multiple results

●     interactively defined Tool Selection if no tool is found.

Depending on the selected option, the Advanced tab page of the Search Tool dialog box shows the solved Tool Query for each operation 
in the Machining Process.

 By default, the Automatic Tool Query option is selected.

In the example below, you can choose one of the tools found in the ToolsSampleMP, or use the Look in combo to select a tool from 
the current document or another tool catalog. 





Operation

This document explains how to customize machining operation settings for Machining products.

Select the Operation tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Default Values the use of default values

After Creation or Machining Process (MP) 
Instantiation

what happens after creating machining operations or machining 
processes

When Copying the duplication of geometry links

Display tool path displays of operations

User Interface dialog boxes of 3-axis surface machining operations.

Default Values

Select the checkbox if you want operations to be created with the values used in the current program. 
The values and units of attributes at the creation step of an operation are set to the values and units of the last edited and 
validated operation whatever its type (that is, exit the operation definition dialog box using OK).

Otherwise the default settings delivered with the application are used.

 By default, this checkbox is selected.

After Creation or Machining Process (MP) Instantiation

Select the desired checkboxes to specify conditions to be applied when you create machining operations or machining 
processes.

Sequence machining operation

Machining operations are automatically sequenced in the current program after creation. 
Otherwise, sequencing can be managed in the feature view.

Search compatible tool in previous operations

When creating an operation, if a compatible tool exists in a previous operation of the current program, it will be set in the 
new operation. 
Otherwise, the operation will be incomplete.



Use a default tool

When creating an operation, a search is done in the document to find a compatible tool. If no compatible tool exists, a 
default one is created in the document and set in the created operation.
If checkbox is not selected, no tool will be defined on the operation.

Start edit mode (not available for machining processes)

When creating a machining operation, Edit mode is automatically started to allow modifying parameters of the created 
operation.
Otherwise, the operation is added to the program but the machining operation editor is not started.

 By default, these checkboxes are selected.

When Copying

Select the checkbox if you want geometry links to be duplicated in a copied operation.

Otherwise the geometry must be defined for the copied operation. Performance is improved when this checkbox is not 
selected.

 By default, this checkbox is selected.

Display

Select the checkbox if you want to display tool paths of operations in the current Part Operation.

 By default, this checkbox is not selected.

User Interface

Select the checkbox if you want to have the possibility of simplifying the dialog boxes of machining operations (that is, you 
can display the minimum number of parameters necessary for a correct tool path). This setting is available for 3-axis surface 
machining operations only. 

 By default, this checkbox is not selected.



Output

This document explains how to customize data output settings for Machining products.

Select the Output tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Post Processor the type of PP files to be used for generating NC code output and 
the path where these files are located

Tool Path Storage the tool path storage capability

Tool Path Edition the tool path edition capability

During Tool Path Computation contact point storage

Tool Output Point type of tool output point

Tool Output Files ... Location default paths for NC output files storage.

Post Processor

Select the desired Processor option:

●     None: no Post Processor is defined. NC code output is not possible in this case

●     Cenit: you can choose from among the Post Processor parameter files proposed by Cenit to generate your NC code

●     IMS: you can choose from among the Post Processor parameter files proposed by Intelligent Manufacturing Software 
(IMS) to generate your NC code

●     ICAM: you can choose from among the Post Processor parameter files proposed by ICAM Technologies Corporation 
(ICAM) to generate your NC code.

Enter the path of the folder containing Post processors. You can choose a folder by clicking the [...] button. File 
concatenation is possible.

 By default, the None option is selected.

Tool Path Storage



Select the desired option to store tool path data either in the current document or in an external file (as a tpl file).

For operations with large tool paths (more than 100 000 points), tool path storage in an external file is recommended. 

 By default, the Store tool path in the current document option is selected.

Tool Path Edition

Select the checkbox if you want to be able to edit tool paths even when the operation is locked. 

This capability is available only for activities with a tool path node in the specification tree.

 By default, this checkbox is selected.

During Tool Path Computation

Select the checkbox if you want to store contact points in the tool path.

Performance is improved when this checkbox is not selected.

 By default, this checkbox is selected.

Tool Output Point

Select the desired option to select one of the following as output point:

●     tool tip

●     tool center point

●     tool center point for ball end tools (that is, any tool with the Ball-end tool attribute selected or an end mill whose nominal 
diameter is equal to twice the corner radius).

Performance is better when the Tool Tip option is selected.

 By default, the Tool Tip option is selected.

Default File Locations



Specify default locations for storing Tool Path files, NC Documentation, and NC Code output. 

You can store tool paths files (tpl files) in the same folder as the CATProcess by selecting the checkbox. This allows you to 
store these files according to your CATProcess context. Otherwise, you can choose another location by clicking the [...] 
button.

For NC Documentation, and NC Code output you can choose a folder easily by clicking the [...] button. 

You can customize the extension to be used for NC Code output (by default, the suffix used is CATNCCode).

 By default, the Tool path: Store at same location as the CATProcess checkbox is not selected.



Program

This document explains how to customize manufacturing program settings for Machining products.

Select the Program tab to customize program auto-sequencing rules and priorities. These settings are 
mainly intended for the administrator.

Make sure that the document in the sequencing rules path (AllSequencingRules.CATProduct in the example 
below) is accessible in Read/Write.

Auto Sequencing

 

Access to sequencing rules settings

Select the Access to sequencing rules settings checkbox to authorize user access to sequencing rules.

You can then specify the path for the rules base 
You can choose a rules base easily by clicking the [...] button.

 By default, this checkbox is selected.

Display sequencing rules and priorities

Select the Display sequencing rules and priorities checkbox to authorize the display of sequencing rules 
and priorities in the user's view. In this case two more checkboxes can be selected in order to: 

●     allow the user to filter rules 

●     allow the user to modify rule priorities.

 By default, these checkboxes are selected.



Photo/Video

This document explains how to customize material removal simulation settings for NC Manufacturing products.

Select the Photo/Video tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Simulation at material removal simulation at program of Part Operation level

Video Video material removal simulation options

Photo Photo material removal simulation options

Performance settings that influence performance

Color color during material removal simulation

Positioning Move allowed tool axis variation between two operations

Simulation at 

Select the desired option to perform material removal simulation at either Program or Part Operation level. 
Depending on the selected level, simulation begins either from the start of the manufacturing program or from the start of 
the Part Operation. 
Best performance is obtained with Program level.

 By default, the Program level option is selected.

Video 

Stop at tool change

Select the Stop at tool change checkbox if you want the Video simulation to stop each time a tool change is encountered 
in the program.

 By default, this checkbox is not selected.

Collision detection

Select the desired Collisions detection option to: 

●     ignore collisions during the Video simulation



●     stop the Video simulation at the first collision

●     continue the Video simulation even when collisions are detected. In this case, you can consult the list of collisions at any 
time during the simulation.

Best performance is obtained when collisions are ignored.

 By default, the Ignore option is selected.

Touch is collision

Select the Touch is collision checkbox if you want touch (or contact) type of collision to be detected. 

 By default, this checkbox is selected.

Multiple Video result on program

Select the Multiple Video result on program checkbox if you want to store video results on more than one operation in 
the program.

 By default, this checkbox is not selected.

Photo

Select the desired Fault box type for examining remaining material or gouges:

●     Transparent: to display a transparent bounding box

●     Wireframe: to display a wireframe bounding box

●     None: if no bounding box is required.

Best performance is obtained when no bounding box is required and the checkbox is not selected.

 By default, the Wireframe option is selected.

Select the checkbox to compute all information at picked point.

 By default, this checkbox is not selected.

Best performance is obtained when Fault box: None is selected and the checkbox is not selected.

Performance 



Tool and faceting

There are three methods of tool faceting used in Video simulation: Standard, Smaller and Larger. 
The number of facets for a tool representation is determined by the chord deviation that is set for the tool diameter (0.005% 
of the tool diameter). 

●     Smaller: The picture shows a rough approximation of a tool with six facets. Note that the chord deviation is always 
inside the actual circle, and that the points are always on the circle (accurate).  

This is the most accurate method for the Arc through Three Points command.

●     Standard: The picture shows a rough approximation of a tool with six facets. Note that the chord deviation is partly 
inside and partly outside the actual circle, and that the points are not always on the circle.

This is the best method for material removal simulation. 
However, this is not suitable for the Arc through Three Points command.

●     Larger: The picture shows a rough approximation of a tool with six facets. Note that the chord deviation is outside the 
actual circle, and that the points are not on the circle.



This is not suitable for the Arc through Three Points command.
However, it can be useful for gouge detection.

 By default, the Standard option is selected.

Photo resolution

Best performance is obtained when the Photo resolution is set to 0. In this case, a detailed simulation of a portion of the part 
can be obtained using the Closeup command.
Increasing the resolution improves machining accuracy and gives a very detailed simulation. However, this requires 
increased memory and computation time.

 By default, this resolution is set to 0.

Tool axis interpolation angle (5-axis only)

Specify the maximum angle that the tool axis is allowed to vary between two consecutive points. 
Best performance is obtained for an angle of 10 degrees. Decreasing the angle improves the precision of the simulation. 
However, this requires increased memory and computation time.

 By default, this angle is set to 1degree.

Optimized rendering for Video

Set the Optimized rendering for Video checkbox to obtain an optimized rendering that improves Video simulation 
performance.
Otherwise, more realistic colors are obtained with a slightly degraded performance. Milling, drilling, and turning operations 
are supported.

 By default, this checkbox is selected.

Color 



Set the tool (and associated machined area) color to be the same as or different from the last tool, or have different colors 
for all tools. Best performance is obtained with same colored tools.

 By default, the All different option is selected.

Assign colors to the different tools using the associated color combo.

Assign colors to tool holders, parts, and fixtures using the associated color combos.

Positioning Move

Set the Maximum tool axis variation that is to be allowed between the end point of an operation and the start point of 
the next operation. If the tool axis varies by an amount greater than the specified value, then the tool is positioned at the 
start of the following operation.

 By default, this angle is set to 1degree.



Reference Information
Reference information on the following topic is provided in this guide.

NC Review of Copy/Index Operations

Essential reference information on the following topics is provided in the NC Manufacturing Infrastructure 
User's Guide.

NC Manufacturing Resources
NC Macros

PP Tables and PP Word Syntaxes
Feeds and Speeds

APT Formats
CLfile Formats 
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NC Review of Copy/Index/Tracut Operations
In general the V4 customer's process is to use the CATIA V4 utility (CATNC) to obtain the APT source file, 
which is then processed by the APT processor. The INDEX, COPY, TRACUT statements as well as the APT 
macros are translated by the APT processor. The result is a clfile which is then processed by the Post 
Processor to get machine code.

This process is not modified when using CATIA V5 to convert CATIA V4 NC programs.

The methodology to get an APT source file allowing a successful association to the program read in NC 
Review, requires that COPY and TRACUT operations are not treated by the V4 CATNC utility, so that the 
corresponding statements remain in the APT source file.

In V5 the customer has the ability to perform replay of V4 Index/Copy operations, and to generate INDEX 
and COPY statements in the APT obtained using the V5 MfgBatch utility.

Note that many V4 NC MILL programs use Index/Copy features and, in some cases, multi-level indexes.

Translation of V4 Copy Entities into V5 Entities

When reading V4 programs in NC Review, each time a Copy operation is treated, it is replaced by a COPY 
operator entity. This COPY operator entity is automatically created.

The possible cases for COPY statements in V4 are as follows:

COPY/n,SAME,nb
COPY/n,TRANSL,dx,dy,dz,nb
COPY/n,XYROT,angle,nb
COPY/n,YZROT,angle,nb
COPY/n,ZXROT,angle,nb
COPY/n,SCALE,factor,nb
COPY/n,MODIFY, $
(MATRIX/ ...),nb

In all cases, the Copy number (n), which is a kind of identifier, and the number of copies (nb) are stored on 
the Copy operator entity.

A specific conversion rule is defined for each of the COPY cases and is described below.

Copy operation type: SAME

This type of Copy is transformed into COPY operator with:
Transformation type: Matrix (identity)
In Absolute Machining Axis System

Copy operation type: TRANSL

This type of Copy is transformed into COPY operator with:
Transformation type: Translation
Translation type: Absolute coordinates
Distance along X, Y, Z: values of the components along each axis.



Copy operation type: XYROT, YZROT, ZXROT

This type of Copy is transformed into COPY operator with:

Transformation type: Rotation
Rotation type: Machining axis (current machining axis to be selected)
Angle: rotation angle in degrees.

Copy operation type: SCALE

This type of Copy is transformed into COPY operator with:

Transformation type: Scale
Machining Axis System: Current Machining Axis System to be selected
Scale factor: scale factor to be applied along the 3 vectors.

Copy operation type: MODIFY MATRIX transformation

This type of Copy is mapped into a Matrix type of COPY operator in Absolute Machining Axis System.

INDEX and INDEX/NOMORE Entities

V4 INDEX and INDEX/NOMORE entities are converted into V5 INDEX and INDEX/NOMORE activities, which 
are considered as markers in the program: they delimit the copied part of the program in the tree.

Translation of V4 Tracut Entities into V5 Entities

When reading V4 programs in NC Review, each time a Tracut operation is treated, it is replaced by a 
TRACUT operator entity. This TRACUT operator entity is automatically created.

The possible cases for TRACUT statements in V4 are as follows:

TRACUT/(MATRIX,TRANSL,dx,dy,dz)
TRACUT/(MATRIX,XYROT,angle)
TRACUT/(MATRIX,YZROT,angle)
TRACUT/(MATRIX,ZXROT,angle)
TRACUT/(MATRIX,SCALE,factor)
TRACUT/(MATRIX/ matrix transformation components)

A specific conversion rule is defined for each of the TRACUT cases and is described below.

Tracut operation type: TRANSL

This type of Tracut is transformed into TRACUT operator with:

Transformation type: Translation
Translation type: Absolute coordinates
Distance along X, Y, Z: values of the components along each axis.

Tracut operation type: XYROT, YZROT, ZXROT



This type of Tracut is transformed into TRACUT operator with:

Transformation type: Rotation
Rotation type: Machining axis (current machining axis to be selected)
Angle: rotation angle in degrees.

Tracut operation type: SCALE

This type of Tracut is transformed into TRACUT operator with:

Transformation type: Scale
Machining Axis System: Current Machining Axis System to be selected
Scale factor: scale factor to be applied along the 3 vectors.

Tracut operation type: MATRIX transformation

This type of Tracut is mapped into a Matrix type of TRACUT operator in Absolute Machining Axis System.

TRACUT/NOMORE Entity

V4 TRACUT/NOMORE entities are converted into V5 TRACUT/NOMORE activities, which are considered as 
markers in the program: they delimit the transformed part of the program in the tree.

Replay and APT Generation

V4 INDEX, INDEX/NOMORE and TRACUT/NOMORE entities have no replay. During APT generation, they 
allow INDEX, INDEX/NOMORE and TRACUT/NOMORE statements to be generated.

As V4 COPY and TRACUT entities are converted into COPY and TRACUT operators, their replay can be done.

During APT generation, COPY and TRACUT entity processing defines a COPY or TRACUT statement, or the 
tool path which has been displayed during Replay, depending on the MfgBatch utility settings.



Methodology
Methodology and conceptual information on the following topics is provided in the NC Manufacturing 
Infrastructure User's Guide.

Machining Processes
Knowledgeware in Machining Processes

CATProduct and CATProcess Document Management
Design Changes and Associativity Mechanisms

Part Operation and Set Up Documents
Opposite Hand Machining

User Features for NC Manufacturing
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Glossary 

                  

A

approach 
macro

Motion defined for approaching the operation start point

auxiliary 
command

A control function such as tool change or machine table rotation. These commands may be 
interpreted by a specific post-processor.

axial 
machining 
operation

Operation in which machining is done along a single axis and is mainly intended for hole 
making (drilling, counter boring, and so on). 

B

back and forth Machining in which motion is done alternately in one direction then the other. 
Compare with one way.

bottom plane A planar geometric element that represents the bottom surface of an area to machine. It is 
normal to the tool axis.

C

clearance 
macro

Motion that involves retracting to a safety plane, a linear trajectory in that plane and then 
plunging from that plane. 

climb milling Milling in which the advancing tool rotates down into the material. Chips of cut material 
tend to be thrown behind the tool, which results to give good surface finish. 
Compare with conventional milling. 

conventional 
milling

Milling in which the advancing tool rotates up into the material. Chips of cut material tend 
to be carried around with the tool, which often impairs good surface finish. 
Compare with climb milling.

D

DPM Digital Process for Manufacturing.

E

extension 
type

Defines the end type of a hole as being through hole or blind.

F



Facing 
operation

A surfacing operation in which material is removed in one cut or several axial cuts of equal 
depth according to a pre-defined machining strategy. Boundaries of the planar area to be 
machined are soft.

Fault Types of faults in material removal simulation are gouge, undercut, and tool clash.

feedrate Rate at which a cutter advances into a work piece. 
Measured in linear or angular units (mm/min or mm/rev, for example).

fixture Elements used to secure or support the workpiece on a machine.

G

gouge Area where the tool has removed too much material from the workpiece.

H

hard A geometric element (such as a boundary or a bottom face) that the tool cannot pass 
beyond.

high speed 
milling (HSM)

Functionality that is supported for Pocketing and Facing operations in which corners and 
transitions in the tool path are rounded to ensure a smooth and continuous cutting effort.

I

inward helical Machining in which motion starts from a point inside the domain to machine and follows 
paths parallel to the domain boundary towards the center of the domain. Compare with 
outward helical.

island Inner domain of a pocket that is to be avoided during machining. It has a closed hard 
boundary.

L

linking motion Motion that involves retracting to a safety plane, a linear trajectory in that plane and then 
plunging from that plane. 

M

machine 
rotation

An auxiliary command in the program that corresponds to a rotation of the machine table.

machining 
axis system

Reference axis system in which coordinates of points of the tool path are given.

machining 
feature

A feature instance representing a volume of material to be removed, a machining axis, 
tolerances, and other technological attributes. These features may be hole type or milling 
type.

machining 
operation

Contains all the necessary information for machining a part of the workpiece using a single 
tool.



machining 
tolerance

The maximum allowed difference between the theoretical and computed tool path.

manufacturing 
process 

Defines the sequence of part operations necessary for the complete manufacture of a part.

manufacturing 
program

Describes the processing order of the NC entities that are taken into account for tool path 
computation: machining operations, auxiliary commands and PP instructions.

manufacturing 
view

The set of machining features defined in the part operation.

multi-level 
operation

Milling operation (such as Pocketing or Profile Contouring) that is done in a series of axial 
cuts.

O

offset Specifies a virtual displacement of a reference geometric element in an operation (such as 
the offset on the bottom plane of a pocket, for example).  Compare with thickness. 

one way Machining in which motion is always done in the same direction. Compare with zig zag or 
back and forth.

outward 
helical

Machining in which motion starts from a point inside the domain to machine and follows 
paths parallel to the domain boundary away from the center of the domain. 
Compare with inward helical.

P

part operation Links all the operations necessary for machining a part based on a unique part registration 
on a machine. The part operation links these operations with the associated fixture and set-
up entities.

pocket An area to be machined that is defined by a closed boundary and a bottom plane. The 
pocket boundary may be either open or closed. The pocket definition may also include a 
top plane and one or more islands.

Pocketing 
operation

A machining operation in which material is removed from a pocket in one or several axial 
cuts of equal depth according to a pre-defined machining strategy. 
The tool path style is either Inward helical, Outward helical or Back and forth.

Point to Point 
operation

A milling operation in which the tool moves in straight line segments between user-defined 
points.

PP instruction Instructions that control certain functions that are auxiliary to the tool-part relationship. 
They may be interpreted by a specific post processor.

PPR Process Product Resources.

Profile 
Contouring 
operation

A milling operation in which the tool follows a guide curve and possibly other guide 
elements while respecting user-defined geometric limitations and machining strategy 
parameters. 

R

retract macro Motion defined for retracting from the operation end point

return macro Motion for linking between paths or between levels.  It  involves retracting to a safety 
plane, a linear trajectory in that plane and then plunging from that plane. 



S

safety plane A plane normal to the tool axis in which the tool tip can move or remain a clearance 
distance away from the workpiece, fixture or machine.

set up Describes how the part, stock and fixture are positioned on the machine.

soft A geometric element (such as a boundary or a bottom face) that the tool can pass beyond.

spindle speed The angular speed of the machine spindle. 
Measured in linear or angular units (m/min or rev/min, for example).

stock Workpiece prior to machining by the operations of a part operation.

T

thickness Specifies a thickness of material to be removed by machining. 
Compare with offset.

top plane A planar geometric element that represents the top surface of an area to machine. It is 
always normal to the associated tool's rotational axis.

tool axis Center line of the cutter.

tool change An auxiliary command in the program that corresponds to a change of tool.

tool clash Area where the tool collided with the workpiece during a rapid move.

tool path The path that the center of the tool tip follows during a machining operation.

total depth The total depth including breakthrough distance that is machined in a hole making 
operation.

U

undercut Area where the tool has left material behind on the workpiece.

Z

zig zag Machining in which motion is done alternately in one direction then the other.
Compare with one way.
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A
approach macro  

Associate APT to NC Lathe Set  

Associate APT to NC Mill Set  

Associate Output NC File to a Program command   

auxiliary command  

axial machining operation  

B
back and forth  

Batch queue management  

Browse V4 NC Lathe model  

Browse V4 NC Lathe operation  

Browse V4 NC Mill model  

Browse V4 NC Mill operation  

Browse V5 Manufacturing CATProcess  

C
clearance macro  

climb milling  
command 

Associate Output NC File to a Program   

Import APT, Clfile or NC code  

Read Manufacturing Data from a V4 Model   

conventional milling  



E
Edit Tool Path  

F
Facing operation  

Fault  

G
Generate Documentation  

gouge  

H
hard geometric element  

high speed milling (HSM)  

I
Import APT, Clfile or NC code command  

Import NC Data  

Inward helical  

Island  

M
Machine Rotation  

machining axis system  

machining feature  

machining operation  

machining tolerance  



manufacturing process  

Manufacturing Program  

manufacturing view  

O
offset  

One way  

Outward helical  

P
Part Operation  

Photo Simulation  

pocket  

Pocketing operation  

Point to Point operation  

PP Instruction  

PPR  

Process List  

Product List  

Profile Contouring operation  

R
Read Manufacturing Data from a V4 Model command   

Resources List  

retract macro  

return macro  

S



soft geometric element  

T
thickness  

Tool Change  

tool clash  

Tool Path computation, APT in batch  

Tool Path computation, CGR in batch  

Tool Path computation, Clfile in batch  

Tool Path computation, interactive  

Tool Path computation, NC code in batch  

Tool Path Replay  

Tool Path Simulation  
Tools Options - Machining 

General  

Operation  

Output  

Photo/Video  

Program  

Resources  

U
undercut  

V
Video Simulation  

Z
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